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Introduction 

Welcome to the Dionex Column Selector, the simulation software for Ion 

Chromatographic retention modeling and optimization. Dionex Column Selector is a 

powerful application that uses previously acquired (embedded) retention data to 

simulate all possible chromatograms in a defined search area. Dionex Column 

Selector determines the optimal eluent composition using a choice of two resolution 

criteria, Minimum Resolution or Normalized Resolution Product. 

Dionex Column Selector is designed with the needs of a range of users in mind. It is 

intended for practical method development, educational and training purposes, 

refinement of existing methods and exploratory investigations including information 

gathering and experimental design overview. 

Dionex Column Selector uses the most advanced retention prediction models 

available today to achieve accurate prediction of chromatograms. Embedded data, 

which have been acquired using a correct experimental design, are used to solve these 

models. 

Dionex Column Selector uses these retention prediction algorithms to predict 

retention data across the entire search area. Dionex Column Selector ranks these 

virtual chromatograms according to two criteria, the Minimum Resolution or 

Normalized Resolution Product. A value of zero indicates that at least one peak pair is 

co-eluting. For the Minimum Resolution criterion, a value of 1.5 is generally regarded 

as baseline separation (< 0.2 % peak area overlap), although a value of 1.2 is often 

considered acceptable resolution for most applications (< 2 % peak area overlap). For 

the Normalized Resolution Product, a value of one indicates that all peaks are evenly 

resolved across the chromatogram. 

Detailed information about the Retention Models and Resolution Algorithms can be 

found in Appendix A. 

Dionex Column Selector has two options for finding the optimum eluent conditions, 

separation or time. A global optimum is defined as the chromatogram with a 

maximum value for the selected resolution criterion. Dionex Column Selector can 

also find the fastest chromatogram for which the value of the resolution criterion does 
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not fall below a specified value. This capability is designed to optimize the speed of a 

separation, rather than the resolution of peaks. 

Dionex Column Selector allows the user to customize a simulation or optimization to 

match their own system through the adjustment of several key parameters including 

column, eluent and analyte selection, peak areas, peak shapes (asymmetry), void time 

and column efficiency (number of theoretical plates). Virtually any system can be 

simulated through the adjustment of these parameters. 

Remember that no two columns are identical and the results obtained using the 

embedded databases in Dionex Column Selector are only considered typical of a 

particular column type. Results obtained may not necessarily match your exact 

column, but every effort has been made to attain as close a match as possible. 

Getting Started contains the following parts: 

• Chapter 1, “Installing Dionex Column Selector,” contains information on 

installation procedures, system requirements, starting, uninstalling and 

upgrading Dionex Column Selector. 

• Chapter 2, “Learning Dionex Column Selector. Tutorial 1 – The Wizard,” 

introduces the Dionex Column Selector wizard. 

• Chapter 3, “Learning Dionex Column Selector. Tutorial 2 – Dual Species 

Eluent Optimization,” introduces the main interface for Dionex Column 

Selector and guides the user through the features of Dionex Column Selector 

that apply to dual species eluent systems, in particular, carbonate eluents. 

• Chapter 4, “Learning Dionex Column Selector. Tutorial 3 – Single Species 

Eluent Optimization,” introduces the main interface for Dionex Column 

Selector and guides the user through the features of Dionex Column Selector 

that apply to single species eluent system, in particular, hydroxide eluents. 

• Chapter 5, “Glossary,” explains some of the terms used in this manual. 

• Appendix A, “Retention Models and Resolution Algorithms,” gives detailed 

information about the models and algorithms used in Dionex Column Selector.
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Chapter 1 

Installing Dionex Column Selector 

1.1. Introduction 

This chapter contains information on the following: 

• system and software requirements. 

• installation instructions. 

• starting Dionex Column Selector. 

• uninstallation instructions. 

1.2. System Recommendations 

Operating System Software 

Dionex Column Selector is a 32-bit Windows# application. To run Dionex Column 

Selector you must have a 32-bit version of Windows such as Windows 95, 98, Me, 

NT 4.0, 2000 or XP. Dionex Column Selector will not run on earlier versions of 

Windows such as Windows 3.1, 3.11, NT 3.5 or NT 3.51. 

Computer Hardware 

Dionex Column Selector is compatible with Intel∗ Pentium® class processors or 

higher, including Pentium Pro, Pentium II, Pentium III, Pentium 4, AMD† K6, 

Athlon®, Duron® and compatible processors. 

Math Coprocessor 

Dionex Column Selector is very floating point intensive and is therefore not 

compatible with processors that do not have a math coprocessor such as 386 and 486 

SX processors. 

                                                 

# Windows is a registered trademark of the Microsoft Corporation 

∗ Intel is a registered trademark of the Intel Corporation 

† AMD is a registered trademark of Advanced Micro Devices 
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Memory 

Dionex Column Selector is compatible with any memory size that runs your version 

of Windows. However for increased performance we recommend at least 32 MB of 

RAM for Windows 95 or Windows 98 and 64 MB of RAM for other Windows 

versions. For large numbers of analytes more memory may be required for acceptable 

performance. 

Hard Drive Storage 

Dionex Column Selector consumes less than 10 MB of hard drive space. 

Display 

Dionex Column Selector requires a minimum resolution of 800 x 600 and 256-color 

depth. However we strongly recommend a display capable of 1024 x 768 or higher 

resolution and at least 16-bit color. 

1.2. Installing Dionex Column Selector 

The Dionex Column Selector installation program will decompress files and install 

them to the correct directories on your computer hard drive. The Dionex Column 

Selector installation program will also set up shortcuts in your start menu. 

If Dionex Column Selector came on the Dionex Manuals and Literature CD-ROM 

click on the Virtual Column link and choose ‘Run this program from its current 

location’. If you downloaded Dionex Column Selector as a self-extracting zip file, 

then it will be necessary to run the Dionex Column Selector Install.exe file. Click yes 

on the security warning and choose a directory to decompress the files to. The 

installer will automatically run the setup.exe file and install the application to your 

hard drive. 

1.3. Starting Dionex Column Selector 

The following is only applicable if Dionex Column Selector has been installed 

correctly on your system. 

• Position the mouse over the Start button of your task bar and left click on 

“Start”. 

• Position the mouse cursor over “Programs” and either left click or wait for the 

programs menu to open. 
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• Position the mouse over “Dionex Column Selector” and either left click or 

wait for the Dionex Column Selector menu to open. 

• Left click on “Dionex Column Selector” to start the application. 

1.4. Uninstalling Dionex Column Selector 

The following is only applicable if Dionex Column Selector has been installed 

correctly on your system. Some minor variations may be noted with different versions 

of Windows. Please contact your computer support staff if the following does not 

apply to your system. 

• Open the Control Panels by either navigating to the “Settings” menu of the 

Start menu, or by opening the “My Computer” window and opening Control 

Panels. 

• Open the “Add/Remove Programs” control panel to show a list of all 

applications currently installed on your computer. Highlight “Dionex Column 

Selector” and click on “Change/Remove”. 

• Follow the on screen instructions to remove Dionex Column Selector from 

your system. It is usually safe to remove all files from your system, but if in 

doubt, contact your local administrator or IS support staff. 
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Chapter 2 

Learning Dionex Column Selector. Tutorial 1 – 
The Wizard 

2.1. Introduction 

In order to run, Dionex Column Selector requires detailed information about the 

system it is trying to model. The Dionex Column Selector Data Editor is the part of 

the application designed to gather this information in as simple a manner as possible. 

This chapter will be divided into three main sections. 

“Getting Started” will outline the procedure of starting Dionex Column Selector, the 

layout of the Data Editor and the files used by the Dionex Column Selector for storing 

column information (the Column Database) and user selection files. 

“Using the Data Editor” takes you through the procedure of using the wizard interface 

and setting up a simulation or optimization. This tutorial will prepare you for Tutorial 

2. 

“Using the Data Editor selection files” introduces you to the concept of selection files, 

which speed up the process of using the Data Editor. 

2.2. Getting Started 

Dionex Column Selector can be started using by using the Windows’ Start menu. You 

can navigate to the Dionex Column Selector short cut and start the application by 

clicking on “Start”, “Programs”, “Dionex Column Selector” and then left clicking the 

Dionex Column Selector application short cut. 

When the program starts a blank main window and the Dionex Column Selector Date 

Editor windows are created, as shown in Figure 1. 
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 Title bar

Eluent and 
Column list 

Analyte list 
Analyte Data Editor 

Column Data Editor 

Figure 1. Dionex Column Selector Data Editor window. The list of eluent / column combinations 

may vary. 

Parts of the Wizard Window: 

Title Bar – Use the title bar to move the window by placing the mouse cursor over 

the bar, click and hold the left mouse button then move the window to the desired 

position and release the mouse button when finished. 

Eluent / Column List – The eluent / column list shows all available databases 

currently installed. Clicking on a particular eluent / column will load that database 

into memory, overwriting any previously selected database. 
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Load and Save Selection Buttons – The load and save selection buttons allow 

a selection to be loaded once a database is selected. 

Column Data Editor – This section displays information about the column 

database that has been loaded. This includes the number of analytes in the database, 

the eluent and column names, the void time and the flow rate. The void time and flow 

rate can be edited to match a particular system. 

Analyte List – When a database is loaded the list of analytes within the database 

will be presented here. 

Analyte Data Editor –Analytes that are selected in the analyte list by checking 

the check box will appear in the analyte data editor with their default peak area, 

asymmetry and plates values. These values can be adjusted by entering new values. 

2.3. Using the Data Editor 

There are four main areas in the Dionex Column Selector Data Editor. 

Choosing an Eluent / Column from the list. 

After the program has been started, the Data Editor should display a list of eluent / 

column entries just like Figure 1. 

• Left click once on “Carbonate : Bicarbonate on a Dionex AS14A 3mm 

column” so that the selection is highlighted. 

Each available eluent / column database in Dionex Column Selector is given an entry 

in this list. The selection of the database will directly affect how Dionex Column 

Selector calculates retention data. In this case Dionex Column Selector will simulate a 

Dionex AS14A 3mm column with a carbonate : bicarbonate dual species eluent. 

Choosing a selection of analytes. 

After loading the column database Dionex Column Selector will list all analytes 

available in the loaded database (Figure 2). The available analytes will vary from 

database to database. 

• Left click once in the square check box to select each of the following 

analytes.  
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o Void Dip, Bromide, Chlorate, Chloride, Fluoride, Iodide, Molybdate, 

Nitrate, Nitrite, Phosphate, Phthalate, Sulfate and Thiocyanate. 

o If necessary use the scroll bar on the right to access analytes below the 

bottom of the wizard window. 

 

Figure 2. Dionex Column Selector Data Editor with the Carbonate : Bicarbonate on a Dionex 

AS14A 3mm column at 25 C database loaded. 

The void dip is always listed first; all other analytes are listed in alphabetical order. 

The number of analytes will display the number of chosen / number available. 
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Editing the analyte data. 

For each selected analyte, Dionex Column Selector will list the default peak area, 

asymmetry value and plate count. Default values for these are included in the column 

database to produce a typical separation and virtual chromatogram. These values can 

be changed to reflect the actual peak areas, asymmetries and plate counts of your 

exact system and column. For now we’ll leave the values as they are, except the void 

peak, which we will set to have a peak area of 0.1 and asymmetry value of 2. 

• Left click once on the Peak Area cell for “Void Dip”. The value should 

become highlighted. 

• Press the delete button to remove the existing value. 

• Enter 0.1 and press the enter key. 

• Left click once on the Asymmetry cell for “Void Dip”. The value should 

become highlighted. 

• Press the delete button to remove the existing value. 

• Enter 2 and press the enter key. 

If you do not select the void dip in step two, you will not be able to adjust its area in 

step three, nor will Dionex Column Selector calculate the resolution of the first peak 

from the void dip. However it will always be shown in the virtual chromatogram. 

The default value for the number of theoretical plates is based on a new column. 

Changes in the number of theoretical plates due to column aging and degradation have 

not been taken into consideration. If the number of theoretical plates of your column 

differs from the default value, this step offers the opportunity to correct for any 

variations. Decreasing the number of theoretical plates will broaden the peaks and 

therefore decrease the resolution of a column. 

Editing the column data. 

The embedded value for the void time is based on a typical system configured with 

that column and guard. Because flow rates and configurations vary, void times also 

vary from system to system. By matching the void time of your system Dionex 

Column Selector can model your system more accurately. Changing the Flow Rate 

variable immediately changes the Void Time in an inversely proportional manner the 



 12

higher the flow rate, the shorter the void time and consequently the shorter the overall 

chromatogram. 

• Double left click on the Void Time text box. The value should become 

highlighted. 

• Press the delete button to remove the existing value. 

• Enter 1.25. 

• Click on the apply button at the bottom right of the Data Editor window. The 

Data Editor window should close and the Dionex Column Selector main 

window should become active. 

This step concludes the “Using the Wizard” tutorial. The “Using the Data Editor 

selection files” tutorial will teach you how selection files can save you time when 

repeating similar optimizations and simulations. Tutorial 2 will teach you how to use 

the main interface of Dionex Column Selector and assumes you have just completed 

this tutorial. 

2.4. Using the Data Editor selection files 

The Data Editor selection files speed up the process of running the wizard when 

similar simulations and optimization have to be repeated. Data Editor selection files 

can be saved at any time after a database is loaded. The selection file stores the 

analytes that are selected as well as the peak areas, asymmetry values, plate counts 

and the void time. The chosen database is not stored in the selection file, so a single 

selection file can be applied to any database. As databases vary on which analytes are 

available, any analytes chosen in a selection file that are unavailable in a database will 

be ignored. A warning will be issued if this circumstance occurs. 

• If the Data Editor window is closed, open it by clicking on the View menu and 

select Data Editor. Click once on the “Carbonate : Bicarbonate on a Dionex 

AS14A 3mm column at 25 C database” and change the peak area, asymmetry 

and plate count of the Void Dip analyte to 0.1, 2 and 6000 respectively. 

• Change the value of the Void Time to 1.25. 

• Left click the “Save” button in the “Selection Files” group box to bring up the 

Save As dialog box. 
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• Enter a File Name for the selection file, taking note of the directory to which it 

is being saved by using the ‘Save in’ drop-down list box. 

• Left click the Save button to save the selection file to the hard drive. This 

should return you to the Data Editor. 

• Left click on Apply to close the Data Editor. The Dionex Column Selector 

main window should become the active window. 

This procedure has saved the selection file to the hard drive. Rather than repeating 

steps two through five of the previous tutorial, it is now possible to open the selection 

file and skip steps two through five and obtain identical results. 

Opening your selection file. 

• Open the data editor by clicking on the View menu and select Data Editor. 

• Left click once on “Carbonate : Bicarbonate on a Dionex AS14A 3mm 

column” so that the selection is highlighted and the existing selections are 

overwritten. The default values should be restored. 

• Left click once on the Load button in the Selection Files group box. This 

should open the Open dialog box. If the directory is different to the one used 

to save the file, navigate to the correct directory by using the ‘Look in’ drop-

down list box. Left click once on the File Name that you chose to save your 

selection file as to highlight it. It should have a .vcx file extension. 

• Left click once on the “Open” button. The open dialog box should close and a 

‘Load Selection File’ confirmation box should appear, see Figure 3. Check all 

four values to overwrite the default values for the void time, peak areas, 

asymmetry values and numbers of theoretical plates. 

• The Data Editor should now be restored to the state it was in when the 

selection file was saved. By not checking various values in the Load Selection 

File confirmation box default values can be used instead of being overwritten 

by the Load Selection function. This is helpful when comparing how different 

columns behave with the same analytes, but with their default column values. 

• Left click once on the “Apply” button. This should close the Data Editor and 

the Dionex Column Selector main window should become active. 
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Figure 3. Load Selection File confirmation box. 

This procedure will produce the same results as the tutorial in Section 2.3. Tutorial 2 

will teach you how to use the main interface of Dionex Column Selector and assumes 

you have just completed this or the previous tutorial. 
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Chapter 3 

Learning Dionex Column Selector. Tutorial 2 – 
The Main Window (dual species eluents) 

3.1. Introduction 

In order to run, Dionex Column Selector requires detailed information about the 

system it is trying to model. The Dionex Column Selector Data Editor is the part of 

the application designed to gather this information in as simple a manner as possible. 

This chapter assumes that the tutorial in Chapter 2 has been recently been completed. 

If not, restart the application and follow the steps in Chapter 2, section 2.3 “Using the 

Wizard”. 

3.2. Getting Started 

After completing the Wizard in the previous chapter, the application should look 

something like Figure 4. 

Parts of the Main Window: 

Control menu button – The control menu contains the commands to resize, 

move, maximize and close the Dionex Column Selector main window. 

Title bar - The title bar contains information about the name of the application 

window and can be used to move the window. 

Minimize button – The minimize button is used to minimize the application 

window to the task bar. The program will still be running but will take no space on the 

desktop. 

Maximize / restore button – The maximize button is used to maximize the 

application windows to use the entire desktop area. When the window is maximized 

the restore button is used to restore the window to its original size. 

Exit button – The exit button is used to close the application. 
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control menu button title bar menu bar 

maximize / restore button
minimize button

exit 
button

track indicators

horizontal track bar

vertical track bar 

virtual chromatogram title
peak label

check boxes 

status bar

unzoom button 

 

Figure 4. Dionex Column Selector main window for dual species eluents. 

Horizontal and vertical track bars – These bars are used to adjust the eluent 

concentration and ratio respectively. They can be adjusted using the arrows keys to 

move one increment/decrement at a time, or by scrolling the track indicator. 

Virtual chromatogram title – The title of the virtual chromatogram includes 

the total eluent concentration (sum of the carbonate and bicarbonate eluents), 

carbonate ratio (percentage of the eluent composed of carbonate) and resolution 

criterion value. 

Unzoom button – This button is used to restore the chromatogram after zooming. 

Asymmetric Peaks check box – This check box is used to turn the asymmetric 

peaks function on and off. 



 17

Auto Scale X-Axis check box – This check box is used to turn the auto scale x-

axis function on and off. 

Peak labels – These labels are used to identify the analyte for each peak. 

3.3. Using Dionex Column Selector 

The Dionex Column Selector main window is split into two sections, the Resolution 

Response Surface and the Virtual Chromatogram. The Resolution Response Surface is 

a contour map of the resolution criteria across the entire search area. Areas of blue are 

maxima (high resolution) and areas of red are minima (low resolution). 

The Virtual Chromatogram is a representation of the chromatogram that would be 

expected with the currently selected eluent conditions. The horizontal and vertical 

scroll bars can be used to select any eluent condition within the search area. The 

program starts by locating the global maximum and setting the initial eluent 

conditions to that value. 

Maximizing the Dionex Column Selector Window 

• Left click once on the maximize / restore button. The window should enlarge 

to fill the entire screen. Dionex Column Selector may take a few seconds to 

recalculate and redisplay the contour plot. 

It is usually easier to work with a maximized window. 

Changing the eluent concentration and ratio 

Dionex Column Selector indicates the currently selected eluent conditions using a 

cross hair on the resolution response surface. If the selected eluent condition lies at the 

edge of the response surface, the cross hair may not be visible. 

• Press and hold the right arrow key. The eluent concentration should increment. 

Hold the right arrow key down until the eluent concentration is 10.08 mM, and 

then release the key. 

• Press the left or right arrow key once to move the eluent concentration one 

increment at a time. 

• At 10.08 mM, the minimum resolution criterion should be 1.246 (your actual 

value might vary slightly). 
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• Press and hold the up arrow key. The eluent ratio should increment. Hold the 

up arrow key down until the eluent ratio is 62.0 % and then release the key. 

• Press the up or down arrow key one to move the eluent ratio one increment at 

a time. 

• The minimum resolution criterion should be 1.200 (your actual value might 

vary slightly). 

• Position the cursor over the track indicator of the horizontal track bar. Press 

and hold the left mouse button. Move the cursor in a straight line to the left. 

The eluent concentration should decrease as the track indicator moves. When 

the eluent concentration reaches 5.60 mM release the left mouse button. 

• Position the cursor over the track indicator of the vertical track bar. Press and 

hold the left mouse button. Move the cursor in a straight line downwards. The 

eluent ratio should decrease as the track indicator moves. When the eluent 

ratio reaches 51.6 % release the left mouse button. 

The eluent concentration can also be modified by left clicking directly on the 

resolution response surface. 

• Position the cursor over the resolution response surface approximately at the 

7.5 mM and 80 % eluent conditions. Left click the mouse button once. The 

eluent conditions should change to approximately these values. 

• Position the cursor over the ‘Criterion’ menu on the menu bar, left click once. 

A menu should appear. Position the cursor over the ‘Find Global Optimum’ 

menu, left click once. 

• You should now be back at the global optimum eluent composition (5.60 mM, 

51.6%) and the minimum resolution criterion should be 1.316 (your actual 

value might vary slightly). 

When you change the eluent conditions using the track bars you may notice a delay of 

a few seconds before the cross hair updates. 

The right pane of the status bar will show the composition of the selected eluent in 

terms of carbonate and bicarbonate concentrations. The sum of these two values will 

always match the total eluent value. 
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Zooming and unzooming a part of the virtual chromatogram 

• Position the cursor so that it is to the left of the void dip but above the height 

of the chloride peak. Press and hold the left mouse button. Move the cursor 

downwards and to the right, a rectangular box should be created from where 

you pressed the left mouse button to wherever you move the cursor. Move the 

cursor to just below the base of the ‘Phosphate’ peak and release the left 

mouse button. 

 

Figure 5. A Virtual Chromatogram displaying the rectangular zoom box. 

• The seven peaks of fluoride, chloride, nitrite, bromide, nitrate, chlorate and 

phosphate should now occupy the entire virtual chromatogram. 

• Left click once on the unzoom button to return to the original virtual 

chromatogram. 

Zooming is always achieved by dragging a rectangle from top left to bottom right. 

Unzooming is achieved by dragging a rectangle from the bottom right to the top left 

(opposite to zooming). 

Auto scaling the X-Axis 

• Left click once on the ‘Auto Scale X-Axis’ check box. The tick in the box 

should disappear and the virtual chromatogram should redraw itself with 96.2 

minutes as the maximum on the time axis (your value might vary). The virtual 

chromatogram should no longer run to the end of the x-axis. 

• Press and hold the left arrow key. The eluent concentration should decrement 

until the minimum of 4.0 mM is reached, then release the key. 
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• As the eluent concentration decremented, the virtual chromatogram should 

have been redrawn taking up more and more of the x-axis until all but the last 

few minutes of the x-axis is used. 

• Press and hold the right arrow key. The eluent concentration should increment. 

Release the mouse button when the eluent concentration reaches 12.48 mM. 

The virtual chromatogram should now only take up about one third of the x-

axis. 

• Left click once on the Auto Scale X-Axis check box. A tick should appear and 

the virtual chromatogram should redraw itself so that the chromatogram uses 

the entire x-axis. This is the same chromatogram, just with a longer x-axis. 

When Auto Scale is turned off the total time of the chromatogram is defined by the 

longest possible chromatogram for the entire search area. 

Finding the optimal and fastest eluent conditions 

• Position the cursor over the ‘Criterion’ menu on the menu bar, left click once. 

A menu should appear (Figure 6). Position the cursor over the ‘Find Fastest 

Chromatogram…’ menu, left click once. A ‘Fastest Chromatogram Finder’ 

dialog box should appear (Figure 7). 

 

Figure 6. Criterion menu. 

 

Figure 7. Fastest Chromatogram Finder dialog box. 

• Enter a minimum acceptable resolution of 1.25 into the dialog box. Click OK. 
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• The eluent conditions should change to 7.04 mM, 90.0 % with a minimum 

resolution criterion of 1.251. The time axis of the Virtual Chromatogram 

should be about 34 minutes (your results may vary slightly). 

• Left click on the ‘Criterion’ menu, then left click on ‘Find Global Optimum’. 

• Dionex Column Selector will return to the global optimum with the time axis 

of the Virtual Chromatogram about 65 minutes. 

If you enter a minimum acceptable resolution greater than the global optimum, 

Dionex Column Selector will tell you that it couldn’t find a chromatogram to match 

that criterion. 

• Left click on the Criterion menu and select “Find Fastest Chromatogram…”. 

• Enter 1.5 into the Fastest Chromatogram Finder dialog box. Dionex Column 

Selector should inform you that there are no chromatograms that match that 

criterion. Click OK to continue. 

Changing the Resolution Criterion 

• Left click on the ‘Criterion’ menu. There should be a tick next to ‘Minimum 

Resolution’, as in Figure 6. Left click on ‘Normalized Resolution Product’. 

After completing the calculations, the Resolution Response Surface contour 

plot should change to a new response surface. The optimum eluent conditions 

should now be 7.84 mM, 73.6 % with a resolution criterion of 0.473 (your 

results may vary slightly). 

• Left click on the ‘Criterion’ menu, and then click on ‘Minimum Resolution’ to 

change the resolution criterion back. 

For difficult separations the minimum resolution criterion is helpful, as it will try to 

maximize the resolution of any difficult to separate peak pairs. For easy separations 

the normalized resolution criterion is helpful, as it will try to maximize the resolution 

of all peak pairs. 

Turning Asymmetric peaks on and off 

When ‘Asymmetric Peaks’ is turned on, the resolution is calculated based on the 

Exponentially Modified Gaussian peak separation. Thus the asymmetry values can 
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impact the overall resolution significantly. Turning asymmetric peaks on and off 

should produce an easily identifiable change in the resolution response surface. 

• Left click on the ‘Asymmetric Peaks’ check box. The tick in the box should 

disappear and the response surface should redraw itself, this time based on 

symmetrical (Gaussian) peaks. The optimum eluent conditions should now be 

5.76 mM, 50.4 % with a resolution criterion of 1.965 (your results may vary 

slightly). 

• Left click on the ‘Asymmetric Peaks’ check box to restore the asymmetry 

(Exponentially Modified Gaussian) calculations. 

Viewing the Resolution Response Surface in true 3D 

• Left click on the ‘View’ menu (Figure 8) and click on ‘3D Plot’. After 

completing some calculations the contour plot should disappear and be 

replaced with a wire frame 3D plot over a contour plot. Two scroll bars should 

appear inside the existing track bars (Figure 9). 

 

Figure 8. View menu. 

 

Figure 9. 3D Resolution Response Surface showing scroll bars. 

• Use the horizontal scroll bar to rotate the wire frame around the z-axis, and the 

vertical inner scroll bar to rotate the wire frame around the x-axis. 

scroll bars
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• Right click on the 3D plot to activate the 3D plot context sensitive menu 

(Figure 10). 3D plotting controls are accessed through this menu. 

 

Figure 10. Response Surface context sensitive menu. 

• Left click on the ‘View’ menu and click on ‘Contour Plot’ to return to the 

default contour map. 

Clicking on the 3D image of the response surface will not change the eluent 

conditions. Only the contour plot can be used in this way. 

Viewing the Retention Times of the analytes 

• Left click on the ‘View’ menu (Figure 8) and click on ‘Retention Times’. A 

‘Dionex Column Selector Retention Time Results’ table should be displayed 

(Figure 11). 
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Figure 11. Dionex Column Selector Retention Time Results Table. 

• Left click on the Print button to print a copy of the retention times. 

• Left click on the Close button to close the window. 

The column on the right gives the resolution between the analyte in that row and the 

next. For example in Figure 11, the resolution between Fluoride and Chloride is 

5.478. 

Calculating the Eluent Composition 

The Eluent Composition Calculator is a useful tool for making your own eluents 

manually. It is also possible to use a gradient or multi-valve pump to mix together 

carbonate and bicarbonate eluents in the correct ratio. 

• Left click on the ‘View’ menu (Figure 8) and click on ‘Eluent Composition’. 

A ‘Dionex Column Selector Eluent Composition’ window should appear 

(Figure 12). 
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Figure 12. Dionex Column Selector Eluent Composition selection window. 

• Left click on ‘Sodium Hydrogen Carbonate’ radio button in the ‘Select a 

Monovalent Eluent Species’ group box, and ‘Sodium Carbonate Monohydrate’ 

radio button in the ‘Select a Divalent Eluent Species’ group box. 

 

Figure 13. Dionex Column Selector Eluent Composition results window. 
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• Left click on the Next button to advance to the results page (Figure 13). A 

description of how to make up the eluent from Sodium Hydrogen Carbonate 

and Sodium Carbonate Monohydrate should be displayed. 

• Left click on the Print button to print the description. 

• Left click on the Close button to close the window. 

Printing the Response Surface and Virtual Chromatogram 

• Left click on the ‘File’ menu (Figure 14) and click on ‘Print’ to print both the 

response surface and the virtual chromatogram. 

 

Figure 14. File menu. 

• To print only the response surface, right click on the response surface to bring 

up the context sensitive menu (Figure 10) and click on ‘Export Dialog’ on the 

menu to open the Exporting Resolution Response Surface window (Figure 

15). 

 

Figure 15. Exporting Resolution Response Surface window. 

• In the ‘Export Destination’ box select ‘Printer’ by left clicking on the Printer 

radio button. 
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• Left click on the Print button. 

On some systems the response surface does not print from the File / Print command. 

The Export Dialog method is a work around for this problem. 

Comparing different Columns 

Dionex Column Selector can calculate the optimized resolution criterion for every 

available column in its databases using the existing analyte list. This is an easy way to 

find if there is a better mobile/stationary phase combination for a particular 

separation. 

• Left click on the Criterion menu (Figure 6) and click on ‘Find Best Column’. 

• Dionex Column Selector will warn you that some analytes are not found in 

certain databases. Iodide, Thiocyanate, Molybdate and Phosphate will not be 

found in the AS10 database, and Iodide and Thiocyanate will not be found in 

the AS15 database. This is because these columns are unsuitable for these 

analytes. 

• After a few moments of calculations a Best Column page will open displaying 

the best criterion value found for each column, see Figure 16. 

• Notice the AS10 and AS15 databases have * marks next to their criterion 

values, this is because these criterion values were calculated without the 

missing analytes being taken into consideration. 

• A low value will tell you that a particular column is unsuitable for a 

separation. A high value tells you that a particular column might be suited to a 

certain separation. 

• In this case it should be obvious that the AS14A is a suitable column for this 

particular set of analytes while the AS16 would be a poor choice. 

• Click Okay to continue. 

The highest criterion value may not necessarily be the best column for a particular 

separation. Further investigation might be necessary to determine other factors such as 

peak asymmetry and chromatogram length, both are important factors before choosing 

a column. 
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Figure 16. Virtual Column Find Best Column results window. 

Restarting Dionex Column Selector 

• Left click on the ‘View’ menu (Figure 8) and click on ‘Data Editor’. The 

Dionex Column Selector data editor should open. 

• Left click once on “Carbonate : Bicarbonate on a Dionex AS14A 3mm 

column” so that the selection is highlighted. 

• Left click once on the Load button in the Selection Files group box. This 

should open the Open dialog box. Left click once on the file name that you 

chose to save your selection file as to highlight it. It should have a .vcx suffix. 

• Left click once on the “Open” button and select all values for the confirmation 

box. The Data Editor should now have a void time value of 1.25. 

• Left click once on the “Apply” button. This should close the data editor and 

the Dionex Column Selector main window should become active. 
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Once the View / Data Editor command has been issued, all data in memory is erased. 

Pressing Cancel on the Dionex Column Selector Data Editor will return you to a blank 

main window. However the last values from the Data Editor will still be selected so 

immediately clicking “Apply” will return you to the main window with the same 

parameters. 

Closing Dionex Column Selector 

• Left click on the ‘File’ menu (Figure 14) and click on ‘Exit’. 

• Alternatively you can use the exit button (Figure 4). 
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Chapter 4 

Learning Dionex Column Selector. Tutorial 3 – 
The Main Window (single species eluents) 

4.1. Introduction 

In order to run, Dionex Column Selector requires detailed information about the 

system it is trying to model. The Dionex Column Selector Data Editor is the part of 

the application designed to gather this information in as simple a manner as possible. 

This chapter will start with a brief guide to the Data Editor, which will open a single 

species eluent database. Familiarity with the Data Editor from Chapter 2 is assumed. 

4.2. The Data Editor 

• Start the application by clicking on the shortcut in the Start Menu, Programs, 

Dionex Column Selector menu. 

• Left click once on ‘Hydroxide on a Dionex AS15 column’ (Figure 17). 

• Tick the following check boxes in the analyte list to select a series of analytes 

– Void Dip, Acetate, Bromide, Chlorate, Chloride, Chromate, Fluoride, 

Methanesulfonate, Nitrite, Oxalate, Phosphate, Succinate and Sulfate. 

• Change the Void Dip peak area to 0.25. 

• Left click the Apply button to complete the Data Editor. 
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Figure 17. Dionex Column Selector Data Editor displaying the contents of a Dionex AS15 

database. 

This procedure will open a Hydroxide database, which is a single species eluent 

database. Dionex Column Selector will automatically detect this and switch to single 
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species eluent mode. This results in the resolution response surface being a line graph 

rather than a contour plot. 

4.3. Getting Started 

After completing the Wizard, the Dionex Column Selector main form should look 

something like Figure 18. 

 

Figure 18. Dionex Column Selector main window for single species eluents. 

The parts and functions of the windows are the same as for dual species eluents 

(Figure 4) with the exception that there is no vertical track bar. 

4.4. Using Dionex Column Selector 

The Dionex Column Selector main window is split into two sections, the Resolution 

Response Surface and the Virtual Chromatogram. The Resolution Response Surface is 

a line graph of the resolution criterion over the entire search area. 

The Virtual Chromatogram is a representation of the chromatogram that would be 

expected at the currently selected eluent condition. The horizontal track bar can be 
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used to select any eluent condition within the search area. The program starts by 

locating the global maximum and setting the initial eluent conditions to that value. 

In this tutorial, only functions that differ with the dual species eluent systems will be 

covered. Functions that are equivalent in both modes have been covered in the 

previous chapter. 

Changing the eluent concentration 

• Press and hold the right arrow key. The eluent concentration should increment. 

Hold the right arrow key down until the eluent concentration reaches 

36.67 mM, and then release the key. 

• Press the left or right arrow keys once to move one increment at a time. 

• The minimum resolution criterion should be 1.113. 

• Position the cursor over the track indicator of the horizontal track bar. Press 

and hold the left mouse button. Move the cursor in a straight line to the left or 

right. The eluent concentration should decrease or increase as the scroll 

indicator moves. When the eluent concentration reaches a desired value 

release the left mouse button. 

The eluent concentration can also be modified by left clicking directly on the 

resolution response surface line. 

• Position the cursor over the red line of the resolution response surface line 

graph at the peak about 29 mM. The cursor should change to a cross hair. Left 

click once while the cursor is in the form of a crosshair. 

Other differences from dual species eluent mode 

• There is no 3D plotting capability for the line graph. 

• There is only one class of eluent species available for eluent composition 

calculations, thus the Dionex Column Selector eluent composition window 

contains only one group box (Figure 19). 
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Figure 19. Dionex Column Selector Eluent Composition window for single species eluents. 

• The line graph cannot be printed individually. 
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Chapter 5 

Glossary 

Terms in bold have their own entry. 

3D Plot: A true three dimensionally rendered representation of a surface. 

Analyte. 

Asymmetry value. 

Auto-Scale: A feature used to ensure that a virtual chromatogram stretches across the 

entire width of the x-axis. 

Check box: A check box consists of a square box and text label that indicates a choice 

the user can make by selecting the box. Any number of the options in the set can 

be selected at a time. 

Column (stationary phase). 

Column database file: A file saved to the hard drive with a .vcl extension that 

contains retention data collected using a correct experimental design. Dionex 

Column Selector uses these databases to solve its internal retention models so that 

retention data can be predicted. 

Database file: see Column database file. 

Dialog box: A window displayed in the user interface to solicit input from the user 

and/or to display output to the user. 

Dionex Column Selector main window: The main working part of Dionex Column 

Selector where the resolution response surface and virtual chromatogram is 

drawn. 

Dionex Column Selector Data Editor: A set of simple steps in a window designed to 

gather detailed information about the system Dionex Column Selector is trying to 

model. 

Drop-down list box: A list box that displays a current setting, but can be opened to 

display a list of choices. 
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Dual Species Eluent. An eluent mixture that contains two species such as bicarbonate 

and carbonate. 

Eluent (mobile phase). 

Eluent composition. 

Embedded. 

Empirical End Points Model. 

Experimental design. 

Global optimum. 

Group box: A rectangle that surrounds a set of controls, such as check boxes or radio 

buttons, and contains a label. The sole purpose of a group box is to organize 

controls related by a common purpose (usually indicated by the label). 

Linear Solvent Strength Model. 

Local optimum. 

Maximize: To display a window at its largest size. 

Minimize: To minimize the size or appearance of a window; in some cases this means 

to hide the window. 

Minimum resolution criterion. 

Normalized resolution product criterion. 

Optimization. 

Peak area. 

Peak pair. 

Radio button: Radio buttons are used to select one of several options. A radio button 

contains a small circle with text next to it, when selected; the circle has a smaller, 

filled circle inside it. Selecting one button in a set deselects the previously selected 

button, so only one of the options in the set can be selected at a time. 

Resolution. 

Resolution criterion. 

Response surface. 
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Restore: To return a window to its pre-minimized or pre-maximized size and 

position. 

Retention factor. 

Retention modeling. 

Retention time. 

Search area. 

Selection File: A file saved to the hard drive with a .vcx extension that contains data 

normally gathered during the Dionex Column Selector Wizard. 

Simulation. 

Single Species Eluent. 

Theoretical Plates. 

Unzoom: Decreases the magnification of a part of a window to restore it to its original 

size. 

Virtual chromatogram: A chromatogram drawn by Dionex Column Selector based 

on predicted retention times and embedded peak areas and asymmetry values. 

Void Dip. 

Void Time (Void Volume). 

Wizard Selection File: See Selection File. 

Zoom: Increases the magnification of a part of a window to aid in visualization.
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Appendix A 

Retention Models and Resolution Algorithms 

Dionex Column Selector includes 2 built in models, one for single species eluents and 

the other for dual species eluents. Both models are based on the Linear Solvent 

Strength model1. 

The single species eluent model is called the Empirical End Points approach to the 

Linear Solvent Strength Model2 and is defined by the following equation, (1): 

1 2log ' log Tk C C E= +  (1) 

where k’ is the retention factor, C1 and C2 are constants for a given analyte and 

column, and ET is the eluent concentration of the eluting species. 

Embedded data, which have been acquired according to a correct experimental design, 

are used to solve the two constants, C1 and C2. For each analyte three retention times 

have been measured at known eluent concentrations, two at the end-points of the 

search area, and one extra point near the center of the search area. Values for C1 and 

C2 are solved for each consecutive pair, giving two equations, one applicable to one 

half of the search area, and the other to the remaining half of the search area3. 

The dual species eluent model expands on the Empirical End Points approach to the 

Linear Solvent Strength Model, allowing prediction for both total eluent concentration 

and the ratio between two eluting species. The interface for Dionex Column Selector 

uses total eluent concentration and eluent ratio (R), however the dual species eluent 

model uses total eluent concentration and the concentration of doubly charged eluent 

species ([E2-]) as parameters. The concentration of doubly charged eluent species can 

be calculated from total eluent concentration and eluent ratio using the following 

equation, (2): 

2 .E
100

TE R−  =   (2) 

Embedded data for dual species eluent systems has once again been acquired using a 

correct experimental design. For each analyte nine retention times have been 

measured at known eluent compositions according to Figure 23. 
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The experimental design can be thought of as consisting of four quadrants, where 

each quadrant is defined by the four retention times at the end points. The dual species 

eluent model is solved separately for each individual quadrant. 

The dual species eluent model comprises three set equations. The first two are given 

by equations (3) and (4): 

11 21log ' log Tk C C E= +  (for low R). (3) 

12 22log ' log Tk C C E= +  (for high R). (4) 

These equations are identical to the single species eluent equations and, once solved, 

can be used to calculate retention times on the top or bottom horizontal lines of the 

search area. 

The third equation is given in equation (5): 

2-
1 2log ' log Ek D D  = +    (5) 

To calculate a retention factor for a given ET and [E2-], equations (3) and (4) must be 

solved for each quadrant initially. Once these equations have been solved, retention 

factors can be calculated for a given ET value at both low and high values of R using 

equations 3 and 4 respectively. These two retention factors are then used to solve for 

D1 and D2 in equation (5). Once D1 and D2 are known for a given ET value, retention 

factors for any value of R can be calculated for that ET value using equation (5). D1 

and D2 must be solved separately for each value of ET . 

Low ET High ET

Low R

High R

Figure 20. Correct Experimental Design for Dual Eluent Species 
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Dionex Column Selector calculates retention times for all selected analytes across the 

entire search area. If a single species eluent is used then 1000 retention times per 

analyte are calculated. If a dual species eluent is used then a grid of 100 x 100 

retention times per analyte are calculated. From this data Dionex Column Selector 

constructs a ‘virtual chromatogram’ for any ET and value of R the user chooses. 

Dionex Column Selector ranks these virtual chromatograms by assigning them a value 

based on one of two resolution criteria, Minimum Resolution or Normalized 

Resolution Product1. For each peak pair a resolution value is calculated using equation 

(6): 

1 '
1 1 ' 2s

k NR
k

α
α

−  =   + +  
 (6) 

where α is the separation factor given by the ratio of retention factors for the peak 

pair, k’ is the average retention factor for the peak pair and N is the number of 

theoretical plates. 

For the minimum resolution criterion the chromatogram is assigned the minimum 

resolution of all the adjacent peak pairs in the chromatogram. The minimum 

resolution criterion gives a value of zero to a chromatogram that has one or more peak 

pairs co-eluting. A value of 1.5 is generally regarded as baseline separation, although 

a value of 1.2 is often considered acceptable resolution for most applications. 

The normalized resolution product (r) is defined by equation (7): 
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where n is the number of peaks and RS i,i+1 is the resolution between peaks i and i+1. 

The normalized resolution product criterion gives a value of zero to a chromatogram 

that has one or more peak pairs co-eluting, and a value of one for a chromatogram that 

has evenly spaced peaks. 
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